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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.
Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The
applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner,
whether as stand-alone products, pre-installed on hardware products,
and any upgrades, updates, patches, bug fixes, or modified versions
thereto. “Designated Processor” means a single stand-alone
computing device. “Server” means a Designated Processor that
hosts a software application to be accessed by multiple users.
“Instance” means a single copy of the Software executing at a
particular time: (i) on one physical machine; or (ii) on one deployed
software virtual machine (“VM”) or similar deployment.
License types
Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only on a number of
Designated Processors up to the number indicated in the order.
Avaya may require the Designated Processor(s) to be identified in
the order by type, serial number, feature key, Instance, location or
other specific designation, or to be provided by End User to Avaya
through electronic means established by Avaya specifically for this
purpose.
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.
Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
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documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note that
each Instance of a product must be separately licensed and ordered.
For example, if the end user customer or Avaya Channel Partner
would like to install two Instances of the same type of products, then
two products of that type must be ordered.
Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.
The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE
AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE 
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS

LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC
VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS ENCODED
BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO
PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION
FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE
OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.
Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

Purpose
This document provides procedures for configuring standalone Avaya WebLM.

The primary audience for this document is anyone who is involved with configuring,
troubleshooting Avaya WebLM for licensing Avaya software products at a customer site. The
audience includes and is not limited to implementation engineers, field technicians, business
partners, solution providers, and customers.

Change history
The following changes have been made to this document since the last issue:

Issue Date Summary of changes
5 July 2019 Added the importCACertificate on page 46 section.
4 January 2019 Updated the Configuring enterprise licensing on page 17 section.
3 December 2018 Added the Retrieving the local WebLM certificate from browser on

page 20 section.
2 November 2018 Added the Adding local WebLM certificate as trusted certificate in

System Manager on page 21 section.

Updated the following sections:

• WebLM overview on page 8

• Configuring enterprise licensing on page 17
1 July 2018 Release 7.1 document.

New in this release
Avaya WebLM Release 7.1.2 supports the following new features and enhancements:

Upgrade through Solution Deployment Manager
You can upgrade WebLM Release 7.1.2 by using Solution Deployment Manager
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The system retains the Host ID after the WebLM system is upgraded.

Browser support
WebLM Release 7.1.2 supports the following browsers:

• Internet Explorer 11.x and later
• Mozilla Firefox 48, 49, and 50

Security enhancements
WebLM Release 7.1.2 supports SHA256 digital signature for signing the license files and the 14-
character host ID.

New in this release
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Chapter 2: WebLM overview

Avaya provides a Web-based License Manager (WebLM) to manage licenses of one or more Avaya
software products for your organization. WebLM facilitates easy tracking of licenses. To track and
manage licenses in an organization, WebLM requires a license file from the Avaya Product
Licensing and Delivery System (PLDS) website at https://plds.avaya.com.

WebLM supports two configurations models:

• WebLM standard model. In this model, a single WebLM server supports one or more licensed
products. The WebLM standard model supports the Standard License File (SLF) and
Enterprise License File (ELF) types.

• WebLM enterprise model. This model includes multiple WebLM servers. One WebLM server
acts as a master WebLM server and hosts the license file from PLDS. The remaining WebLM
servers act as the local WebLM servers and host the allocation license files from the master
WebLM server. You require an ELF to set up the WebLM enterprise model. PLDS generates
license files that are SLFs or ELFs.

Note:

The master and local WebLM servers must be deployed on the same major release. The
master WebLM server must be on same or latest service pack than the local WebLM
server resides on.

For example, if the local WebLM server is on Release 7.1, the master WebLM server must
be on Release 7.1, 7.1.1, 7.1.2, or 7.1.3. The master WebLM server cannot be higher than
Release 7.1.x.

You can purchase two products and choose the enterprise model of licensing for one product and
the standard model of licensing for the other product. PLDS generates a separate license file for
each product.

The license file is an SLF or ELF based on how the product is configured in PLDS. Verify the
installation options that the product supports before you install the WebLM server. To configure the
standard licensing, you can use an ELF or SLF. To configure enterprise licensing, you must have an
ELF. After you install the license file on the WebLM server, a product with an ELF can have multiple
instances of the WebLM server. However, a product with an SLF can have only one instance of the
WebLM server.

The license file of a software product is in an XML format. The license file contains information
regarding the product, the major release, the licensed features of the product, and the licensed
capacities of each feature that you purchase. After you purchase a licensed Avaya software product,
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you must activate the license file for the product in PLDS and install the license file on the WebLM
server.

July 2019 Administering standalone Avaya WebLM 9
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering standalone Avaya WebLM


Chapter 3: Getting started with WebLM

Logging on to the WebLM web console
Before you begin
Obtain a user account to log on to the WebLM web console. If you do not have a user account, go
to the Avaya Support website at https://support.avaya.com to create your account.

About this task
The WebLM web console is the main interface of Avaya WebLM. You must log on to WebLM web
console to perform any task. The WebLM home page displays the navigation menu that provides
access to shared services to perform various operations that WebLM supports.

Procedure
1. On the web browser, type https://<Fully Qualified Domain Name>>:52233/

WebLM, the WebLM URL.

2. In the User Name field, type the user name.

3. In the Password field, type the password.

4. Click Log On.

The system validates the user name and password with the WebLM user account.

• If the user name and password match, the system displays the WebLM home page with
the WebLM <version_number>.

• If the user name and password does not match, WebLM displays an error message and
prompts you to enter the user name and password again.

Next steps
If you have logged on to WebLM web console, for the first time, change the password.

Installing a license file
Before you begin
Licenses installed for WebLM Release 7.1 and later, must support SHA256 digital signature and
14–character host ID.
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About this task
You can install a license file on the WebLM server. Use the Uninstall functionality to remove the
license file from the WebLM server.

Before you begin
• Get the license file from the Avaya Product Licensing and Delivery System (PLDS) website at 

https://plds.avaya.com.
• Log on to the WebLM server.
• For standard license file, remove the older license file before you install the new file.

Note:
The system displays an error message if an older license file is still available.

For centralized license file, the system automatically overwrites the older license file during
installation.

If you experience problems while installing the license file, see “License file installation errors” in
Administering standalone Avaya WebLM.

Procedure
1. In the left navigation pane, click Install license.

2. On the Install license page, click Browse, and select the license file.

3. Read the terms and conditions, and click Accept the License Terms & Conditions.

4. Click Install.

WebLM displays a message on successful installation of the license file. The installation of
the license file might fail for reasons, such as:

• The digital signature on the license file is invalid. If you get such an error, request PLDS
to redeliver the license file.

• The current capacity use exceeds the capacity in the installed license.

Related links
Scenario 01 on page 50

Install license field descriptions
Name Description
Enter license path The complete path where the license file is saved.
Browse The option to browse and select the license file.
Avaya Global License Terms & Conditions Avaya license terms and conditions that the user

must agree to continue the license file installation.

Installing a license file
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Button Description
Install Installs the product license file.

Licensed products

Viewing the license capacity and utilization of the product
features

Before you begin
• Log on to the WebLM server.
• Install the license file on the WebLM server for the licensed product.

About this task
Use this procedure to view the license capacity and license utilization of a product for which you
installed a license file.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click View license capacity.

Related links
View license capacity field descriptions on page 12
View license capacity field descriptions on page 12

View license capacity field descriptions
Licensed Features
Use the View license capacity page to view the total number of feature licenses in the license file
and the current usage of those licenses.

Field Description
Feature (License Keyword) The display name of the licensed features of the product and the

keywords of each feature. The keywords represent the licensed feature in
the license file.

Expiration Date The date on which the feature license expires.
Licensed capacity The number of licenses for each licensed feature. The system fetches the

number of feature licenses information from the license file.
Currently Used The number of feature licenses that are currently in use by the licensed

application. For features of type Uncounted, the column displays Not
counted.

Getting started with WebLM
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Acquired Licenses
The Acquired licenses table displays information about the licenses acquired by the licensed
application. You can view the information in the table only if the licensed product has acquired
feature licenses.

Field Description
Feature The feature keyword for each licensed feature that is currently acquired

by a licensed application.
Acquired by The name of the licensed application that has acquired the license.
Acquirer ID The unique identifier of the licensed application that has acquired the

license.
Count The number of feature licenses that are currently acquired by the licensed

application.

Related links
Viewing the license capacity and utilization of the product features on page 12

Viewing peak usage for a licensed product
Before you begin

• Log on to the WebLM server.
• Install the license file on the WebLM server for the licensed product.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click View peak usage.

Related links
View peak usage field descriptions on page 13

View peak usage field descriptions
Use this page to view the usage information of feature licenses of a licensed application at
different time intervals.

Field Description
Feature (License Keyword) The display name of the licensed features of the

product and the keywords of each feature. The
keywords represent the licensed feature in the
license file.

Currently Allocated The number of feature licenses purchased by the
organization.
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Field Description
Usage: qty/% The number of feature licenses for each licensed

feature that a licensed application currently uses.
The column also displays the percentage of usage.

For example, if 50 feature licenses are available
and five feature licenses are used by applications,
the column displays 5/10%.

Peak Usage (Last 7 days): qty/% The highest number of feature licenses for each
licensed feature that has been used in the last
seven days.

For example, if the peak usage for a feature license
in the past seven days was 25, and the number of
available licenses during these seven days was 50,
then the column displays 25/50%.

Peak Usage (Last 30 days): qty/% The highest number of feature licenses for each
licensed feature that has been used in the past 30
days.

For example, if the peak usage for a feature license
in the past 30 days was 50, and the number of
available licenses during these 30 days was 50,
then the column displays 50/100%.

Time of Query The date and time when the last usage query for
WebLM was executed.

Status The success or failure of the last usage query
executed for the WebLM server.

Enterprise Licensing

Viewing the license capacity of the licensed features of a product
Before you begin
Log on to the WebLM server.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click View by feature.

Related links
View by feature field descriptions on page 15
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View by feature field descriptions
Name Description
Feature (License Keyword) The display name and the keyword for the licensed features of the

product.
License Capacity The total number of feature licenses that the organization purchases for

each feature.
Currently available The number of floating licenses of each feature that is currently available

with the master WebLM server.

The feature licenses that are not allocated to any local WebLM server are
known as floating licenses.

Note:

For uncounted features, this column displays “Not counted”.

Related links
Viewing the license capacity of the licensed features of a product on page 14

Viewing the connectivity status of the local WebLM servers
Before you begin
Log on to the WebLM server.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click View by local WebLM.

The page displays the connectivity status of the local WebLM servers.

Related links
View by local WebLM field descriptions on page 15

View by local WebLM field descriptions
Use this page to view the information related to local WebLM servers of a product.

Name Description
Local WebLM name Specifies the name of the local WebLM server.
IP address Specifies the IP address of the local WebLM server.
Last contacted Specifies the date and time when the local WebLM

server was last contacted.
Status Lists the success or failure of the last connection

request to each local WebLM server.
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Related links
Viewing the connectivity status of the local WebLM servers on page 15

Validating connectivity to local WebLMservers for a product
Procedure

1. In the left navigation pane, click Licensed Products from the enterprise product name.

2. In the left navigation pane, click Local WebLM Configuration.

3. On the Local WebLM Configuration: View Local WebLMs page, select the local WebLM
servers you want to validate for connectivity.

4. Click Validate Connectivity to query the selected local WebLM servers.

Result
The status column on the Local WebLM Configuration: View Local WebLMs page of the selected
WebLM servers displays whether the connection request made to the local WebLM server is
successful or not.

Related links
View Local WebLMs field descriptions on page 16

View Local WebLMs field descriptions
Use this page to validate the local WebLM server connection. To validate the connection, the
master WebLM server tries to connect to the specified local WebLM server.

Note:

To validate the connectivity of a local WebLM server, the local WebLM server must be already
added for the product.

Name Description
Local WebLM Name The name of the local WebLM server.
IP Address IP address of the local WebLM server.
Last Contacted Date and time when the local WebLM server was

last contacted.
Status Lists the success or failure of the last connection

request to each local WebLM server.

Button Description
Validate Connectivity Validates the connectivity of the selected WebLM

server.
Check All Selects all the local WebLM server.
Clear All Clears the selections of local WebLM servers.
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Related links
Validating connectivity to local WebLMservers for a product on page 16

Configuring enterprise licensing
Before you begin

• Log on to WebLM Home.
• Install the enterprise license file on the WebLM server for the product.

To verify the license file for a product, in the left navigation pane, click Licensed products
and select the product. The content pane displays the product name, System Identification
number (SID), and the license file type installed for the product at the top of the page.

Note:
System Manager WebLM can be configured as master WebLM but cannot be configured as
local WebLM to an external WebLM.
Standalone WebLM OVA-based deployment can be configured as master WebLM or local
WebLM.
No other WebLM flavor can be configured as master WebLM.

Enterprise Master WebLM Enterprise Local WebLM
System Manager WebLM Yes No
Standalone WebLM OVA-based
deployment

Yes Yes

Other WebLM flavors No Yes

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. In the navigation pane, click Enterprise configuration.

3. On the Enterprise Configuration page, enter the appropriate information in the fields.

For more information, see “Enterprise Usage field descriptions”.

To successfully set up and configure the master WebLM server, enter valid information in
the mandatory fields that are marked with a red asterisk.

4. In the Master WebLM Configuration section, enter the name, description, and IP address
of the master WebLM server.

5. In the Default Periodic Operation Settings section, enter the retry count and the retry
interval in minutes for the periodic operations.

6. In the SMTP Server settings section, enter the name of the SMTP server.

7. In the E-mail notification settings for periodic operation section, perform the following:

a. Set the E-mail notification to On.

Enterprise Licensing
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b. In the E-mail address field, enter an email address.

c. To add the email address to the list of recipients for the WebLM server to send email
notifications, click Add To List.

8. In the Default Periodic License Allocation Schedule section, select the day and time for
periodic license allocations.

The values you enter in this section remain as the default setting for periodic allocation for
all local WebLM servers in the enterprise.

9. In the Default Periodic Usage Query Schedule section, select the day and time of the
query for periodic usage.

The values you enter in this section remain as the default setting for periodic usage for all
local WebLM servers in the enterprise.

Note:

For any periodic operations, you must perform the manual allocation at least one time.

10. Click Submit.

The system validates the information. The system displays the host ID in the Host ID field.
The host ID is the host ID of the computer where you installed the WebLM server.

Related links
Enterprise Configuration field descriptions on page 18

Enterprise Configuration field descriptions
Use this page to specify the master WebLM server settings and the default settings for the
periodic operations of the server. The settings you specify in the Enterprise Configuration Web
page applies to the entire enterprise unless you override the setting while you add a local WebLM.

The master WebLM server uses the settings of the periodic operations to query itself and generate
the usage report for licenses.

Master WebLM Configuration

Name Description
Name Specifies the name of the WebLM server.
Description Provides a brief description of the server.
IP address Specifies the IP address of the WebLM server.
Host ID Specifies the host ID of the computer where you

installed the WebLM server. You cannot edit the
Host ID field.

Getting started with WebLM

July 2019 Administering standalone Avaya WebLM 18
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering standalone Avaya WebLM


Default periodic operation settings

Name Description
Retry count Specifies the number of times a master WebLM

server must try to connect to a local WebLM server
for a periodic operation after a connection failure.

For example, set the count to 2. The master
WebLM server makes an initial unsuccessful
attempt to connect to a local WebLM server. The
master WebLM server makes two more attempts to
connect to the local WebLM server.

Retry interval Specifies the duration in minutes, within which the
retry count specified in the Retry count field must
be carried out.

For example, suppose the Retry count is 2 and the
Retry interval is 10 minutes. If the attempt to
connect to the server fails, the master WebLM
server makes two attempts in 10 minutes to connect
to the local WebLM server.

SMTP Server Settings

Name Description
Server name Specifies the name of the SMTP server.

E-mail notification settings for periodic operation

Name Description
E-mail notification Specifies the e-mail notification. The notification

options are:

• On: Sends an e-mail notification to the
administrator if the periodic operations fail.

• Off: Does not send an e-mail notification to the
administrator if the periodic operations fail.

E-mail address Specifies the e-mail address to which the WebLM
application sends the e-mail notification if the
periodic operations fail to execute.

Note:

Click Add To List to add the e-mail address in
the list of recipients who must receive the e-
mail notification of the periodic operation
status.

E-mail addresses Provides the list of e-mail addresses to which the
WebLM application sends the e-mail notifications.

Table continues…
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Name Description
Add To List Adds the e-mail address that you enter in the E-

mail address field to the list of recipients who must
receive the e-mail notification of the periodic
operation status.

Remove Selected Removes the selected e-mail address from the E-
mail addresses field.

Default Periodic License Allocation Schedule

Name Description
Day The day of the week on which the master WebLM

server must send the ALF (Allocation license file)
again to the local WebLM server.

Time The time of the day specified in the Day field when
master WebLM must send the ALF again to the
local WebLM server.

Default Periodic Usage Query Schedule

Name Description
Day The day of the week on which the master WebLM

server must query local WebLM servers for usage
reports.

Time The time of the day you specify in the Day field
when the master WebLM server must query local
WebLM servers for usage reports.

Button Description
Submit Saves the enterprise configuration.
Reset Resets the values in the fields to the values you

previously saved.

Related links
Configuring enterprise licensing on page 17

Retrieving the local WebLM certificate from browser
About this task
Use this procedure to retrieve the local WebLM certificate from the Firefox browser.

Procedure
1. On the web browser, type the local WebLM server URL, https://<Fully Qualified

Domain Name>:<PortNumber>/WebLM.
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2. On the address bar, click the Lock icon.

3. Click the Show connection details icon.

4. Click More Information.

5. Click View certificates.

6. On the Certificate dialog box, do the following:

a. Click the Details tab.

b. Click Export.
c. Save the certificate to your local computer.

Adding local WebLM certificate as trusted certificate in System
Manager

About this task
To add standalone WebLM as local WebLM in System Manager (master WebLM), you must add
local WebLM certificate to the truststore of System Manager.

Before you begin
Download the local WebLM certificate using the browser.

Procedure
1. On the System Manager web console, click Services > Inventory
2. In the navigation pane, click Manage Elements.

3. On the Manage Elements page, select an element, and click More Actions > Manage
Trusted Certificates.

4. On the Manage Elements page, select System Manager, and click More Actions >
Manage Trusted Certificates.

5. On the Trusted Certificates page, click Add.

6. On the Add Trusted Certificates page, in Select Store Type to add trusted certificate,
select the store type as TM_INBOUND_TLS.

7. Click Import from file.

8. Type the file name or click Browse to select a file.

Note:

System Manager validates the file type. If you provide an invalid file type, the system
displays an error message.

9. Click Retrieve Certificate.

10. Click Commit.

Enterprise Licensing

July 2019 Administering standalone Avaya WebLM 21
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering standalone Avaya WebLM


11. Restart the JBoss service on System Manager.

Managing local WebLM
Adding a local WebLM server

Before you begin
• Log on to the WebLM server.
• Install the enterprise license file.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Local WebLM Configuration > Add local WebLM.

3. On the Local WebLM Configuration: Add local WebLM page, enter the appropriate
information.

To successfully set up and configure the local WebLM server, fields that are marked with a
red asterisk (*) are mandatory.

For detailed descriptions of the fields, see “Add local WebLM field descriptions”.

4. In the Local WebLM Configuration section, enter the name, description, IP address, and
port of the local WebLM server.

5. Select a protocol for the master WebLM server to communicate with the local WebLM
server.

6. In the Periodic license allocation schedule section, select the day and time for periodic
license allocations.

7. In the Periodic usage query schedule section, select the day and time of the query for
periodic usage.

8. Click Configure and validate.

The system validates the information. If the information is valid, the system displays the
host ID of the computer where the server is installed in the Host ID field.

Related links
Add local WebLM field descriptions on page 22

Add local WebLM field descriptions
Local WebLM configuration

Field Description
Name The name of the server.
Description A brief description of the server.

Table continues…
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Field Description
IP Address A unique IP address of the server. If you enter an IP

address that is already configured for a local
WebLM server, the system displays the message:
IP Address is being duplicated.

Protocol The protocol scheme over which the master
WebLM server communicates with the local WebLM
server.

Note:

If the local WebLM server that you add is a
standalone WebLM server in Virtualized
Environment, use HTTPS. You cannot use
HTTP for communication with the standalone
WebLM server in Virtualized Environment.

Port The port number on which the master WebLM
server communicates with the local WebLM server
in the specified protocol scheme.

Host ID The host ID of the computer on which you installed
the server. You cannot edit the Host ID field.

Periodic License Allocation schedule

Field Description
Day The day of the week on which the master WebLM

server must send the ALFs again to the local
WebLM server.

By default, the system displays the settings
specified in the Enterprise Configuration. If you
change the default settings, the new settings
override the settings of the Enterprise
Configuration. However, the change in the schedule
is only applicable to this local WebLM server.

Time The time of the day specified in the Day field when
the master WebLM server must send the ALFs
again to the local WebLM server. By default, the
system displays the settings you specified in the
Enterprise Configuration. If you change the default
settings, the new settings override the settings of
the Enterprise Configuration. However, the change
in the schedule is only applicable to this local
WebLM server.
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Periodic Usage Query schedule

Field Description
Day The day of the week on which the master WebLM

server must query local WebLM servers for usage
reports. By default, the system displays the settings
you specified in the Enterprise Configuration. If you
change the default settings, the new settings
override the settings of the Enterprise
Configuration. However, the change in the schedule
is only applicable to this local WebLM server.

Time The time of the day specified in the Day field when
the master WebLM server must query local WebLM
servers for usage reports.

By default, the system displays the settings you
specified in the Enterprise Configuration. If you
change the default settings, the new settings
override the settings of the Enterprise
Configuration. However, the change in the schedule
is only applicable to this local WebLM server.

Button Description
Configure and validate Configures the local WebLM server and validates

the creation of the local WebLM server.
Back Returns to the View local WebLMs page.

Removing a local WebLM server
Before you begin

• Log on to the WebLM server.
• Install the enterprise license file.
• Add at least one local WebLM server.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Local WebLM Configuration > Delete local WebLM.

3. On the Local WebLM Configuration: Delete local WebLM page, select the local WebLM
server that you want to delete.

4. Click Delete.

Note:

The system displays a warning message before removing the local WebLM server
from the master WebLM server.

5. Click OK.
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Related links
Delete local WebLM field descriptions on page 25

Modifying a local WebLM server configuration
Before you begin

• Log on to the WebLM server.
• Install the enterprise license file.
• Add at least one local WebLM server.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Local WebLM Configuration > Modify local WebLM.

3. On the Local WebLM Configuration: Modify local WebLM page, select the local WebLM
server that you require to configure.

4. Click Modify.

The system displays another Local WebLM Configuration: Modify local WebLM page with a
different set of WebLM configuration fields.

5. Modify the information in the following fields:

• In the Local WebLM configuration section, Name, Description, Protocol, and Port
• In the Periodic License Allocation schedule section, Day and Time
• In the Periodic Usage Query schedule section, Day and Time

6. Click Modify.

The system saves your changes.

Related links
Local WebLM configuration - modify field descriptions on page 26
Modify local WebLM field descriptions on page 26

Delete local WebLM field descriptions
Use this page to delete a local WebLM server.

Name Description
Local WebLM name The name of the local WebLM server.
IP address The IP Address of the local WebLM server.
check box Use to select the local WebLM servers that you

require to delete.
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Button Description
Delete Removes the local WebLM server you selected.
Reset Clears the selection of the local WebLM servers.

Local WebLM configuration - modify field descriptions
Use this page to select the local WebLM server whose information you want to modify.

Name Description
Local WebLM name The name of the local WebLM server.
IP address The IP address of the server.
Select Select the local WebLM server you want to modify.

Button Description
Modify Saves the local WebLM configuration changes.

Note:

The system opens another Modify Local
WebLM page with the fields you must modify.

Reset Clears the selection of the local WebLM servers.

Modify local WebLM field descriptions
Use this page to modify the information of a local WebLM server.

Local WebLM configuration

Name Description
Name Specifies the name of the server.
Description Displays a brief description of the server.
IP Address Specifies the IP address of the server.

Note:

You cannot modify the information in the IP
address field.

Protocol Specifies the protocol scheme over which the
master WebLM server listens to the local WebLM
server.

Note:

If the local WebLM server that you add is a
standalone WebLM server in Virtualized
Environment, use HTTPS. You cannot use
HTTP for communication with the standalone
WebLM server in Virtualized Environment.

Table continues…
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Name Description
Port Specifies the port number on which the master

WebLM server listens to the local WebLM server in
the specified protocol scheme.

Host ID Specifies the host ID of the computer where you
installed the server.

Note:

You cannot modify the information in the Host
ID field.

Periodic License Allocation schedule

Name Description
Day Specifies the day of the week on which the master

WebLM server must send the ALFs again to the
local WebLM server.

Time Specifies the time of the day you entered in the Day
field when the master WebLM server must send the
ALFs again to the local WebLM server.

Periodic Usage Query schedule

Name Description
Day Specifies the day of the week on which the master

WebLM server must query the local WebLM servers
for usage reports.

Time Specifies the time of the day you entered in the Day
field when the master WebLM server must query
the local WebLM servers for usage reports.

Button Description
Modify Navigates to the Modify Local WebLM page for the

local WebLM server you select.
Back Discards the configuration changes and takes you

back to the Modify local WebLM page.

Usages
Viewing usage summary

Before you begin
Log on to the WebLM server.
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Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Usages.

The system displays the Usage Summary page.

Related links
Usage Summary field descriptions on page 29

Viewing usage by WebLM
Before you begin
Log on to the WebLM server.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Usages > Usage by WebLM.

The system displays the Usages: Usage by WebLM page.

3. In the Select WebLM field, select the master or local WebLM server.

4. Click Query System.

Related links
Usage by WebLM field descriptions on page 30

Viewing enterprise usage of a license feature
Before you begin
Log on to the WebLM server.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Usages > Enterprise Usage.

The system displays the Usages: Enterprise Usage page.

3. In the Select Feature (License Keyword) field, select the licensed feature.

The page displays the usage of the licensed feature for the master WebLM server and the
local WebLM servers.

Related links
Enterprise Usage field descriptions on page 31

Querying usage of feature licenses for master and local WebLM servers
Before you begin
Log on to the WebLM server.
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Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Usages > Query Usage.

The system displays the Usages: Query Usage page.

3. To view the usage details by feature licenses of a server, select the master or local WebLM
server.

4. Click Query Usage.

If you select all WebLM severs or click Check All and click Query usage, the system
displays the progress of the query request.

Result
If you select one local WebLM server, the Usages: Usage by WebLM page displays the details of
the local WebLM server you selected.

Related links
Query Usage field descriptions on page 32

Usage Summary field descriptions
Use this page to view the usage summary for a master WebLM server, a local WebLM server, or
all the WebLM servers of the product.

Name Description
WebLM Name Displays the names of the master WebLM server

and local WebLM servers of the product.
IP address Specifies the IP address of the master WebLM

server and local WebLM servers of the product.
Time of Query Specifies the date and time when the system

executed the last usage query for the WebLM
server. If the status of the last usage query is
Failed, this column also displays the date and
time of the usage query that was last successful.

Status Specifies the success or failure status of the last
usage query that the system executed for each
WebLM server. The Status column of a WebLM
server remains blank if the server is not queried
even once for feature license usage. The usage
query can be a periodic usage query or a
nonperiodic usage query.

Related links
Viewing usage summary on page 27
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Usage by WebLM field descriptions
Use this page to query the feature license usage by the master and local WebLM servers.

Name Description
Select WebLM The master and local WebLM servers for which you

can view the usage.
Feature (License Keyword) The name and keyword of the counted features of

the product.
Currently Allocated The number of feature licenses for each feature that

the system currently allocates to the selected
WebLM server. For the master WebLM server of the
product, this column lists the floating licenses
available with the server.

Usage: qty/% The number of feature licenses for each feature that
the licensed applications currently use from the
allocated feature licenses. The column also displays
the percentage of usage.

For example, if 50 feature licenses are allocated
and applications use five feature licenses, this
column displays 5/10%.

Peak Usage (last 7 days): qty/% The highest number of feature licenses for each
feature that the applications use in the past seven
days. The column also displays the percentage of
peak usage.

For example, if the peak usage in the past seven
days was 25 and 50 feature licenses were available
during the peak usage calculation, the column
displays 25/50%.

Peak Usage (last 30 days): qty/% The highest number of feature licenses for each
feature that the applications use in the past 30
days. The column also displays the percentage of
peak usage.

For example, if the peak usage in the past 30 days
was 50 and 50 feature licenses were available
during the peak usage calculation, the column
displays 50/100%.

Time of Query The date and time when the system executed the
usage query for the WebLM server you select.

Status The success or failure of the last usage query
process executed for each WebLM server. The
Status column remains blank if the server is
queried even once for feature license usage. The
usage query can be a periodic usage query or a
nonperiodic usage query.
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Button Description
Query System Queries the selected WebLM server for the feature

license usage.

Related links
Viewing usage by WebLM on page 28

Enterprise Usage field descriptions
Use this page to view the feature license usage of all WebLM servers for the selected feature.

Name Description
Select Feature (License Keyword) Specifies the license features for which you can

view the license usage.
License capacity Specifies the total number of feature licenses the

organization purchases for each feature.
Available Lists the number of licenses currently available with

the master WebLM server.
WebLM Name Specifies the names of the WebLM servers of the

product.
Currently Allocated Specifies the number of feature licenses that the

system currently allocates to the WebLM servers for
the selected feature.

Usage qty/% Specifies the number of feature licenses that the
licensed applications currently use, from the
allocated feature licenses for the selected feature.
The column also displays the percentage of usage.
For example, if 50 is the allocated feature licenses
and 5 feature licenses have been used by the
applications, this column displays 5/10%.

Peak Usage (last 7 days): qty/% Specifies the highest number of feature licenses
that applications use in the past seven days for the
selected feature. The column also displays the
percentage of peak usage. For example, if the peak
usage in the past seven days is 25 and the feature
licenses those were available during the peak
usage calculation is 50, the column displays
25/50%.

Peak Usage (last 30 days): qty/% Specifies the highest number of feature licenses
that applications use in the past 30 days for the
selected feature. The column also displays the
percentage of peak usage. For example, if the peak
usage in the past 30 days is 50 and the feature
licenses those were available during the peak
usage calculation is 50, the column displays
50/100%.
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Name Description
Time of Query Specifies the date and time when the system

executes the usage query for the selected feature.
Status Specifies the status of the last usage query process

that the system executes for each WebLM server.
The status can be Success or Failure.

Related links
Viewing enterprise usage of a license feature on page 28

Query Usage field descriptions
Use this page to query the master WebLM server, a local WebLM server, or all the WebLM servers
of the product for the feature license usage report.

Name Description
WebLM Name The names of the master and the local WebLM

servers of the product as links. To view the feature
license usage of a server, select the name of the
required server in the WebLM Name column.

Note:

If the specified WebLM server is not queried
even once for feature license usage, the table
on the Usage by WebLM page remains blank.

IP address The IP address of the master WebLM server and
the local WebLM servers of the product.

Time of Query The date and time when the system executes the
last usage query for the WebLM server. If the status
of the last usage query is Failed, the Time of
Query column displays the date and time of the
usage query that was last successful.

Note:

If the server does not receive a query request
even once for feature license usage, the Time
of Query column of a WebLM server remains
blank.

Status The success or failure of the last usage query that
the system executes for each WebLM server. If the
server does not receive a query request even once
for feature license usage, the Status column of a
WebLM server remains blank. The usage query can
be a periodic usage query or a nonperiodic usage
query.

Select Check box Use to select the WebLM server for which you
require to determine the usage query.
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Button Description
Check All Selects all the WebLM servers.
Clear All Clears the selections for all the WebLM servers.
Query Usage Queries the WebLM servers of the product you

select for their feature license usage report.

Related links
Querying usage of feature licenses for master and local WebLM servers on page 28

Allocations
Viewing allocations by features

Before you begin
Log on to the WebLM server.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Allocations > View by feature.

The system displays the Allocations: View by Feature page.

Related links
Allocations by Features field descriptions on page 34

Viewing allocations by the local WebLM server
Before you begin
Log on to the WebLM server.

Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Allocations > View by local WebLM.

The system displays the Allocations: View by Local WebLM page.

3. In the Select Local WebLM field, select the local WebLM server.

Result
The page displays the allocation details for the local WebLM server you select.

Related links
Allocations by Local WebLM field descriptions on page 35
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Changing allocations of licensed features for a local WebLM server
Use this functionality to change the license allocations of a feature that resides on a local WebLM
server for the product.
Procedure

1. Log in to the master WebLM server.

2. In the left navigation pane, in Licensed products, click the required product.

3. Click Allocations > Change allocations.

The system displays the Allocations: Change Allocations page.

4. In the New Allocation column, enter the number of licenses you require to allocate for the
feature that resides on a local WebLM server.

5. Click Submit Allocations.

Related links
Change Allocations field descriptions on page 36

Allocations by Features field descriptions
Use this page to view the feature license allocation information for each counted type feature of
the product.

Name Description
Feature (License Keyword) Specifies the name and license keyword of the

counted features of the product.
Local WebLM Name Specifies the name of the local WebLM servers of

the product. By default, this column is blank. The
system displays the names of the local WebLM
servers only when you select the arrow head in the
Feature (License Keyword) column. If a local
WebLM server does not exist for the product, the
Local WebLM Name column remains blank for all
the licensed features.

IP address Specifies the IP addresses of the local WebLM
servers of the product. By default, this column is
blank. The system displays the IP address of the
local WebLM servers only when you select the
arrow-head in the Feature (License Keyword)
column. If a local WebLM server does not exist for
the product, the IP address column remains blank
for all the licensed features.

License Capacity Specifies the total number of feature licenses
purchased by the organization for the respective
feature.

Table continues…
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Name Description
Currently Allocated Specifies the total number of feature licenses of the

respective feature that the system allocated to the
local WebLM servers of the product. If a licensed
feature is not allocated to any local WebLM server,
the system displays zero in the Currently
Allocated column for the licensed feature.

Available Lists the number of floating licenses of the
respective feature that is currently available with the
master WebLM server.

Note:
To view the information about the number of feature licenses of a feature that the system
allocates to each local WebLM server, click the arrow-head beside the name of the required
feature. The system displays new rows below the feature row with the feature license
allocation information for each local WebLM server to which the feature is allocated.

Allocations by Local WebLM field descriptions
Use this page to view the feature license allocation information by local WebLM.

Name Description
Select Local WebLM Specifies the local WebLM servers for which you

can view the feature license allocation information.
Last Allocation Specifies the date and time when feature licenses

were last allocated to the local WebLM server you
select.

Status Specifies the success or failure status of the last
license allocation process that the system executes
for the local WebLM server you select. The
allocation process can be a periodic allocation
process or a nonperiodic allocation process. If the
status of the last license allocation process is
Failed, and if the status of a previous license
allocation process for the server is Success, the
system displays the date and time of the last license
allocation process that was successful in the Last
Allocation field.

Feature (License Keyword) Specifies the name and license keyword of the
counted features that the system allocates to the
local WebLM server you select.

License Capacity Specifies the total number of feature licenses the
organization purchases for each feature.

Currently Allocated Specifies the total number of feature licenses of
each feature that the system allocates to the local
WebLM server you select.
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Enterprise Licensing

July 2019 Administering standalone Avaya WebLM 35
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering standalone Avaya WebLM


Name Description
Available Lists the number of licenses currently available on

the master WebLM server for allocation to local
WebLM servers.

Change Allocations field descriptions
Use this page to change current feature license allocation information for each local WebLM
server of a product.

Name Description
Feature (License Keyword) The name and license keyword of the counted

features that the system allocates to the local
WebLM server you select.

Local WebLM Name The name of the local WebLM server.
IP address The IP addresses of the local WebLM servers of the

product.
License Capacity The total number of feature licenses that the

organization purchases for each feature.
Currently Allocated The total number of feature licenses of each feature

that the system allocates to the local WebLM server
you select.

Currently Used The total number of feature licenses of each feature
that the product uses.

Available The number of floating licenses of each feature that
is currently available with the local WebLM server.

New Allocation The number of new licenses that the system
allocates to a local WebLM server.

Button Description
Submit Allocations Allocates the number of feature licenses that you

specify in the New Allocation field to the
corresponding local WebLM servers.

Reset Resets the values that you specify in the New
Allocation field to the previously saved value.

Periodic status of the WebLM server
Viewing the periodic status of the master and local WebLM servers

Before you begin
Log on to the WebLM server.
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Procedure
1. In the left navigation pane, in Licensed products, click the required product.

2. Click Periodic status.

The system displays the Periodic Status page.

Periodic Status field descriptions
Use the Periodic Status option to view the status of periodic operations such as the periodic
allocation of the feature licenses to the local WebLM server and querying of the local WebLM
server for usage report.

Periodic Allocation

Name Description
Local WebLM Name Specifies the name of the local WebLM server of a

product.
IP Address Specifies the IP addresses of all the local WebLM

servers of the product.
Last Allocation Displays the date and time when the system

executed the last periodic license allocation process
for each local WebLM server. If the status of the last
periodic license allocation process is Failed, the
Last Allocation column displays the date and time
of the periodic license allocation process that was
last successful.

Status Displays the success or failure status of the last
periodic license allocation process that the system
executed for each local WebLM server.

Periodic Usage

Name Description
WebLM Name Displays the name of the master WebLM server and

local WebLM servers of a product.
IP Address Displays the IP addresses of the master and local

WebLM servers of a product.
Last Usage Query Displays the date and time when the system

executed the last periodic usage query for each
WebLM server. If the status of the last periodic
usage query is Failed, the Last Usage Query
column also displays the date and time of the
periodic usage query that was last successful.

Status Displays the success or failure status of the last
periodic usage query that the system executed for
each WebLM server. If the server is not queried
even once for feature license usage, the Status
column of a WebLM server remains blank.
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Migrating enterprise WebLM model to standard WebLM model
About this task
Use this procedure to migrate:

• Specific local WebLM to standard WebLM model
• All local WebLM servers and master WebLM server to standard WebLM server

Before you begin
1. Free all the licenses acquired from local WebLM and master WebLM for the particular

Enterprise License product.
2. During the migration, ensure that the product does not acquire licenses from local WebLM

and master WebLM.

Procedure
1. Log on to the master WebLM server.

2. In the left navigation pane, in Licensed products, click the required product.

3. Click Local WebLM Configuration > Delete local WebLM.

4. On the Local WebLM Configuration: Delete local WebLM page, select the local WebLM
server that you want to delete.

5. Click Delete.

The system displays a warning message before removing the local WebLM server from the
master WebLM server.

6. Click OK.

This concludes the migration of a specific local WebLM to the standard WebLM model.

To migrate all local WebLM servers and master WebLM server to standard WebLM server,
continue the next steps.

7. Delete all configured local WebLM servers by using Step 2 through Step 6.

8. Disable configured email notifications by using the following:

a. In the navigation pane, click Enterprise configuration.

b. In E-mail notification settings for periodic operation, set E-mail notification to Off.
c. Click Submit.

9. (Optional) Uninstall the enterprise license by using the following:

a. In the left navigation pane, click Uninstall license.

b. On the Uninstall License page, select the required license.

c. Click Uninstall.

The system displays the Uninstall License Confirmation page.
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d. Click Uninstall to confirm the license uninstallation.

Result
You can now use Master WebLM and Local WebLM as independent Standard WebLM.

Related links
Delete local WebLM field descriptions on page 25
Enterprise Configuration field descriptions on page 18
Uninstall license field descriptions on page 39

Uninstalling the license file

Uninstalling a license file
Procedure

1. In the left navigation pane, click Uninstall license.

2. On the Uninstall License page, select the required license.

3. Click Uninstall.

The system displays the Uninstall License Confirmation page.

4. Click Uninstall to confirm the license uninstallation.

If the license file you selected cannot be uninstalled, the system displays only the Cancel
button.

Related links
Uninstall license field descriptions on page 39

Uninstall license field descriptions
Use this page to remove a license file from the WebLM server for a licensed product. The
Allocation Table License Files table displays the ALF files. You cannot uninstall the ALF files.

Field Description
License Host Name The WebLM server where the license files are

installed.
Host ID The host ID of the license file.
Products The products for which licenses are installed on the

WebLM server.
SID The System ID of the license file.

Table continues…
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Field Description
Select Check box Use to select the license files that you require to

remove from the WebLM server.

You cannot uninstall the ALF license files.

Button Description
Uninstall Removes the selected license files from the WebLM

server.

Server properties

Viewing the server properties
Before you begin
Log on to the WebLM server.

Procedure
In the left navigation pane, click Server properties.

Note:

The host ID specified in PLDS is embedded in the license file. You can install the license file
only if the host ID of the server that hosts WebLM matches the host ID in the license file.
Therefore, when you request for a license file, specify the correct host ID of the server that
hosts WebLM.

Related links
Server Properties field descriptions on page 40

Server Properties field descriptions
Server Host ID

Field Description
Primary Host ID The MAC address of the server.

For non-VMware deployments, the primary host ID is the MAC address of
the server.

For VMWare deployments, the primary host ID is a 14 character
combination of the IP address and the UUID of the system.

You must use the host ID to generate licenses which you later install on
the current instance of the WebLM server.
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Setting the usage history count
Before you begin
Log on to the WebLM server.

Procedure
1. In the left navigation pane, click Server properties.

2. In the Usage history count section, set the Count from the list.

3. Click Submit.

The Count specifies the number of usage query results that the server maintains.

Note:

You can view the Usage history count section only if you install at least one
enterprise license file in the WebLM server.

Managing users

Adding a new user
Before you begin
Log on to the WebLM server.

Procedure
1. In the left navigation pane, click Manage users.

2. Click New.

3. On the New User page, type the appropriate values in the User Name, Password, and
Confirm Password fields.

4. Click Add.

Related links
Manage users field descriptions on page 42

Deleting the user
Before you begin
Log on to the WebLM server.
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Procedure
1. On the left navigation pane, click Manage users.

2. On the Manage Users page, select the users you require to delete.

3. Click Delete.

4. To delete the users, on the confirmation dialog box, click OK.

Related links
Manage users field descriptions on page 42

Editing the user password
Before you begin
Log on to the WebLM server.

Procedure
1. In the left navigation pane, click Manage users.

2. On the Manage Users page, select the user you require to modify.

3. Click Edit.
4. In the New Password field, type a new password.

5. In the Confirm Password field, type the new password again.

6. Click Change.

Note:

You cannot edit the user name from the Manage Users page.

Related links
Manage users field descriptions on page 42

Manage users field descriptions
Name Description
User Name The user name of the admin or non-admin WebLM

user.

Table continues…

Getting started with WebLM

July 2019 Administering standalone Avaya WebLM 42
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering standalone Avaya WebLM


Name Description
Reset Password Specifies whether the log-in password has changed

at least once after the creation of the user ID.

The Reset Password column displays true for user
IDs whose password is not changed even once
after the creation of the ID. The column displays
false for user IDs whose log-in password is
changed at least once.

Button Description
New Adds the user to the WebLM database.
Edit Modifies the user password.
Delete Deletes the user from the WebLM database.

Logging out of the WebLM server
Before you begin
Log on to the WebLM server.

Procedure
At the top-right corner of the web page, click Log off.

The system displays the log-in page.
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Chapter 4: WebLM Certificate Management

Toggling WebLM server certificate
About this task
From WebLM Release 7.1 and later, the server uses a self-signed certificate. The self-signed
WebLM server certificate is created at the time of deploying the standalone WebLM OVA. The
self-signed certificate details are as follows:

• Common Name (CN) is the system host name
• Validity is five years from the time of installation

All releases before WebLM Release 7.1 uses SIP CA signed demo certificate.

Note:
Avaya does not recommend using demo SIP CA signed certificate as it is not NIST compliant.
It is recommended to use unique Identity certificate of key size at least 2048 bit and signed
using SHA256WithRSA algorithm.

Procedure
1. To toggle between SIP CA certificate and self-signed certificate run the command:

toggleWebLMCert.

The system toggles WebLM Certificate between default demo
certificate and self-signed certificates.
The currently self-signed certificate is active cert.

2. Type 1 and press Enter to toggle with default demo certificate.

3. Press any other key to exit 1.

The system restarts the Tomcat server.

Replacing SIP CA or self-signed certificate with third-party
certificate

Before you begin
• The certificate must be of 2048-bit key size (preferred).
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• Obtain a third-party certificate in PKCS12 format from third-party CA or generate using some
tools like OpenSSL. Remember the password used to generate the certificate.

• The P12 file must contain the private key and corresponding public certificate along with all
the intermediate CA certificates and root CA certificate in its chain of trust.

• Copy the PKCS12 certificate file to $CATALINA_HOME/webapps/WebLM/WEB-INF/
directory. Where $CATALINA_HOME represents the base directory for the tomcat instance.

Procedure
1. Stop the Tomcat server.

2. Locate the Connector in Tomcat server.xml file that you want to secure using a
certificate. The server.xml file is located in the conf folder of your Tomcat home
directory.

3. Specify the correct keystore filename and password in the connector configuration.

For example:
<Connector acceptCount="100" clientAuth="false" disableUploadTimeout="true" 
enableLookups="false" keystoreFile="${catalina.base}/webapps/WebLM/WEB-INF/ 
<your_keystore_name.p12> " keystorePass=" <your_keystore_password> " 
SSLEnabled="true" keystoreType="PKCS12" maxHttpHeaderSize="8192" 
maxSpareThreads="75" maxThreads="300" minSpareThreads="25" port="52233" 
scheme="https" secure="true" sslProtocol="TLS" 
sslEnabledProtocols="TLSv1.2,TLSv1.1,TLSv1" ciphers="…"/>

4. Save changes to the server.xml file.

5. Start the Tomcat server.

Import CA certificate into WebLM client truststore
WebLM client residing on products connect to the WebLM server using HTTPS for licensing.

To authenticate the server, import the server public certificate into the client trust store.

You can add or set the WebLM server CA certificate in the trusted store on the following clients:

• C++: Refer the WebLM C++ client product documentation to add or set the WebLM server
CA certificate in the trusted store.

• Java: See “Importing CA certificate into WebLM Java client truststore”.

Importing CA certificate into WebLM Java client truststore
About this task
Use this procedure on the Java client machine which communicates with WebLM server.

Import CA certificate into WebLM client truststore
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Procedure
1. Refer the respective product documentation which is hosting the WebLM client to locate

trusted_weblm_certs.jks and trustedcert.properties files used by the
WebLM Java client on the application.

2. Import CA certificate into the client truststore trusted_weblm_certs.jks by running
the following command:
keytool -import -alias weblm -file <server_public_certificate> -keystore 
<truststore_filename> 

where,

truststore_filename is WebLM truststore used by WebLM Java client

server_public_certificate is the PEM encoded certificate that is used on server
side.

3. At the prompt, type the password mentioned in the trustedcert.properties file.

4. Restart the application to reflect the changes.

importCACertificate
Import the CA certificate into truststore of standalone WebLM OVA-based deployment.

Syntax
importCACertificate [-certpath <full path of the certificate>] [-storepass <weblm 
keystore password>] [-alias <alias>] 

-certpath Full path of the PEM encoded certificate to import.

-storepass WebLM key store password.

-alias Alias name to assign.

Description
importCACertificate alias used to import the CA certificate into WebLM truststore.
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Chapter 5: Troubleshooting standalone
WebLM

Overview
This section provides detailed information to help you resolve issues with the standalone version
of WebLM. The section is intended for people who install, configure, and maintain WebLM for both
standard and enterprise license configurations.

Adopter application cannot communicate with WebLM
Server

Cause
Due to higher security settings on the WebLM Server Release 7.1 system, the adopter
applications that are using WebLM Server earlier to Release 7.1 might not communicate with
WebLM Server to fetch the license file from WebLM Server by using the WebLM client.

Solution
To fetch the license file from the WebLM Server Release 7.1 system, locate the
trusted_weblm_certs.jks file from the adopter application system, take the backup of the
file, delete the file, and then restart the adopter application.
Do this if the adopter application cannot communicate with WebLM Server regardless of the
WebLM Server version on the adopter system.

Adopter application cannot communicate with WebLM
Server

Cause
If you provide a slash at the end of the licensing URL, the adopter application will not be able to
communicate with WebLM Server. For example: https://IP_Address:52233/WebLM/
LicenseServer/
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The adopter application that is being licensed displays the following alarm:
Alarm Id: 400 Severity: Critical Component: Resource ManagerDate & Time:
<Timestamp>Description: WebLM Connection Failed Probable Cause: WebLM
server is down or unreachable.Corrective Action: Check status of
configured WebLM server and verify network connectivity to it.
Solution
To fetch the license file from WebLM Server, type the URL as https://IP_Address:52233/
WebLM/LicenseServer.

WebLM launching errors

Launching of WebLM fails
Symptom The system fails to launch WebLM with the following errors:

• A 404 error when you gain access to WebLM from the browser.
• A Connection refused error when you communicate with WebLM server

using the client API.

Cause of
the issue

• If the Tomcat service fails to run.
• If you use an incorrect URL to gain access to WebLM.
• If you have network connectivity issues while gaining access to WebLM from a

remote computer.
• If the configuration of HTTPS in the server.xml file of Tomcat is incorrect.

• If several applications run on the server that hosts Tomcat, and the server
caters to a large number of simultaneous requests.

Related links
Proposed solution 1 on page 48
Proposed solution 2 on page 49
Proposed solution 3 on page 49
Proposed solution 4 on page 50
Proposed solution 5 on page 50

Proposed solution 1
Before you begin
Obtain a valid license file for the WebLM server.
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Procedure
If Tomcat is started as a service, to verify that the service is running, perform one of the following:

• For Windows, to verify the status of the Tomcat service, click Control Panel > Administrative
Tools > Services.

• For Linux, at the command prompt, enter service tomcat status.

From the list of services, the system must display the status of Apache Tomcat as Started.

Proposed solution 2
Procedure
To gain access to the WebLM server, enter the URL in one of the following formats:

• From the browser, enter one of the following:

- For IPv4, use the following:

• http://<HOST_NAME/IPv4_ADDRESS>:<HTTP_PORT>/WebLM/index.jsp
• https://<HOST_NAME/IPv4_ADDRESS>:<HTTPS_PORT>/WebLM/index.jsp

- For IPv6, use the following:

• http://<HOST_NAME/[IPv6_ADDRESS]>:<HTTP_PORT>/WebLM/index.jsp
• https://<HOST_NAME/[IPv6_ADDRESS]>:<HTTPS_PORT>/WebLM/index.jsp

• From the client API, enter one of the following:

- For IPv4, use the following:

• http://<HOST_NAME/IPv4_ADDRESS>:<HTTP_PORT>/WebLM/LicenseServer
• https://<HOST_NAME/IPv4_ADDRESS>:<HTTPS_PORT>/WebLM/LicenseServer

- For IPv6, use the following:

• http://<HOST_NAME/[IPv6_ADDRESS]>:<HTTP_PORT>/WebLM/LicenseServer
• https://<HOST_NAME/[IPv6_ADDRESS]>:<HTTPS_PORT>/WebLM/
LicenseServer

Proposed solution 3
About this task
To gain access to the WebLM server over the network:

Procedure
1. Ensure that the connectivity to the network exists.
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2. Verify that the firewall does not block any ports that Tomcat listens to.

Proposed solution 4
Procedure
To use HTTPS protocol, you must enable HTTPS in one of the following files:

• On a Linux system. $CATALINA_HOME/conf/server.xml
• On a Windows system. %CATALINA_HOME%\conf\server.xml

Proposed solution 5
A number of applications run on the WebLM server that hosts Tomcat, and the server caters to
several requests simultaneously.

Procedure
1. Ensure that the Tomcat configuration supports the load expected on the system.

2. If required, modify the Tomcat configuration to support more requests simultaneously. For
details of changing the Tomcat configuration, see Tomcat configuration guide.

License file installation errors

Installation of license file on the WebLM server fails

Scenario 01
The installation of a license file on the WebLM server fails for several reasons. The following
sections provide some troubleshooting scenarios and proposed solutions:

Symptom1 The system displays the following error:
Error installing license. An error occurred while
performing license installation checks. Please ensure that
all the required steps were performed before deploying
WebLM server.

Cause of the
issue

• If the following sequence of events occurs:
1. You run an instance of the Tomcat/WebLM server as root.
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2. You successfully install a license file for a product, for example product A.
3. The instance of the Tomcat/WebLM server exits ungracefully. As a result,

the file cleanup process fails.
4. Redeploy or restart the Tomcat/WebLM server as another user, for

example tomcat5. As a result, an existing license file fails to load on
startup.

5. If you attempt to install a new license file for the same product, product A.
• If multiple instances of the WebLM server run on the same server, and you

install a license file for a product on an instance of the WebLM server when a
license is already hosted on another instance of the WebLM server.

• If the user ID you use to start the Tomcat service does not have the write
permission for the following directory:
- On a Linux system, /var/tmp
- On a Windows system, C:\temp

Related links
Proposed solution on page 51

Proposed solution
Before you begin
Obtain a valid license file for the WebLM server.

Procedure
1. Start only one instance of the WebLM server on the system at a time.

2. Ensure that the user ID you use to start the Tomcat service has write permissions for the
following directory:

• On a Linux system, /var/tmp
• On a Windows system, C:\temp

3. If the system still displays the error, perform the following:

a. Verify that a lock file exists and has the .##machineNameproductName.l file
naming convention.

b. To view the lock file, perform one of the following:

• On a Windows system, the lock file exists in the C:\temp directory and the file is
hidden. Enable the view hidden files option using the following steps:

a. Browse to the C:\temp directory.

b. Click Tools > Folder Options.

c. Click the View tab.
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d. In the Advanced settings section, select Files and Folders > Hidden files
and folders > Show hidden files and folders.

e. Click Apply and then click OK.

The system displays the lock file in the list.

• On a Linux system, to view the lock file, enter ls –al /var/tmp.

c. If the lock file exists, stop Tomcat gracefully and delete the lock file.

d. If the license file exists, remove the file from the $CATALINA_HOME/webapps/
WebLM/licenses directory on a Linux system or %CATALINA_HOME%\webapps
\WebLM\licenses on a Windows system. The license file must have a .xml
extension.

e. Start Tomcat.

4. To install the license file, on the WebLM Home page, click Install license and proceed with
the installation steps.

For instructions to install a license file, see Installing a license file on page 10.

The system installs the license file on the WebLM server.

Scenario 02
Symptom 2 The system displays the following error:

Error installing license. License file is invalid or not
created for this server. License file was not installed.

Cause of the
issue

The error occurs due to one of the following reasons:
• If the MAC address in the license file fails to match the MAC address of the

system hosting the WebLM server.
• If you modify the license file.
• If the license file name contains special characters that the system fails to

support.

Related links
Proposed solution on page 53
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Proposed solution
Procedure
Depending on the cause of the error, perform one of the following:

• Perform the following:

a. Log on to the WebLM server.

b. On the left navigation pane, click Server properties and verify that the MAC address in
the license file matches the MAC address displayed on the Server Properties page.

The Server properties page displays the MAC addresses for all available NICs on the
system on which you installed WebLM. The MAC address in the license file must match
the MAC address of the system on which the WebLM server is running.

• Verify that the license file is not edited. If the license file is edited, revert the changes or install
the original license file that you receive from PLDS.

• Verify that the name of the license file does not contain the following characters:

- On a Windows system, % ^ { } # `

- On a Linux system, % ^ { } # ` [ ]

If the name of the license file uploaded on the WebLM server contains any of the characters
that the system does not support, remove the characters from the file name and install the
license file.

Important:

The system supports the following sets of characters in the name of the license file for both
Windows and Linux: ~ ; . , ! ‘ = + @ ( ) & $ - and whitespace.

Scenario 03
Symptom
3

The system displays the following error:
Error installing license. License installation failed. The
product already exists with a SID
<SID_IN_EXISTING_LICENSE_FILE>, which is different than the
one present, <SID_IN_NEW_LICENSE_FILE>, in new license file.

Cause of
the issue

If a license file for a product is already installed on the WebLM server and you
attempt to install another license file for the same product with a different System
Identification number (SID) on the WebLM server.
You encounter this issue when you have a license file generated by Remote
Feature Activation (RFA) installed on a WebLM server for a product. The license
file that RFA generates has an RFA generated SID value. You then receive an
updated license file for the same product from PLDS. The new license file for the
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same product contains a different SID value. The system displays the error
message when you attempt to install the new file on the existing file.

Related links
Proposed solution on page 54

Proposed solution
When the existing license file and the new license file for a given product have different SID
values, you cannot install the new license file when a license file exists on the WebLM server. You
must uninstall the existing license file from the WebLM server and then install a new license file on
the server.

Before you begin
Log on to the WebLM server.

Procedure
1. For a standard or an enterprise license file, where enterprise or local WebLM configuration

is not set:

a. To uninstall the existing license file, click Uninstall license, and follow the instructions
provided in Removing a license file on page 39.

Note:

The system removes the existing license file for the product. You lose all the
existing usage data for the product.

b. To install a new license file, click Install license, and follow the instructions provided
in Installing a license file on page 10.

The system installs the new license file for the product.

2. For an enterprise license file, where you added local WebLM servers:

a. In the left navigation pane, click Licensed products and select the product name.

b. Click Local WebLM Configuration > Delete local WebLM.

c. Click Delete.

Note:

The system removes the license file allocated to the local WebLM servers that
you added to this enterprise setup. As a result, licensed applications which are in
the process of acquiring licenses from the local WebLM servers fail to acquire any
new licenses or renew the existing licenses.

d. To uninstall the existing license file, click Uninstall license, and follow the instructions
provided in Removing a license file on page 39.
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Note:

The system removes the existing license file for the product. You lose all the
existing usage data for the product.

e. To install a new license file, click Install license, and follow the instructions provided
in Installing a license file on page 10.

The system installs the new license file for the product. You must configure the
enterprise again, add local WebLM servers, and allocate the license for the local
WebLM servers you added.

Scenario 04
Symptom 4 The system displays the following error:

Unsupported content type. License contents must be ”text/
xml”.

Cause of the
issue

The error occurs due to the following reasons:
• If you click Install before you select a license file.
• If you fail to select a license file that has a .xml extension.

• If the license file you use to install contains invalid XML content.
• If the browser settings are incorrect.
• If the registry settings are incorrect.

Related links
Proposed solution on page 55

Proposed solution
The installation of the license file might fail if you install the license file on a WebLM server from a
particular browser or a system. However, you can successfully install the same file on the WebLM
server by gaining access to the same WebLM server from another browser or system. The failure
might be due to invalid browser or registry settings.

Before you begin
• Obtain a valid license file.
• Log on to the WebLM server.

Procedure
1. To install a new license file, click Install license, and follow the instructions provided in 

Installing a license file on page 10.
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2. Verify that the browser setting are appropriate. You can use the default settings to upload
the license file.

3. To verify that the registry settings on Windows are appropriate, perform the following
procedure:

a. At the command prompt, enter regedit.

b. On the Registry Editor window, ensure that the Extension Key in the
HKEY_CLASSES_ROOT/MIME/Database/Content Type/application/xml
directory is .xml.

4. Verify if you can install the license file from a different browser or from a different system.

WebLM password errors

WebLM password resetting
Symptom When you provide your credentials to log in to WebLM, the system

displays a log-in failure error message.

Cause of the issue You forget or lose the password for the WebLM login.

Related links
Proposed solution 1 on page 56
Proposed solution 2 on page 57

Proposed solution 1
If a non-admin user fails to log in to the WebLM server using the existing credentials, you must
reset the password.

Procedure
1. Log in to the WebLM as admin.

2. On the left navigation pane, click Manage users.

3. Select the user whose password you want to reset.

4. Enter a new password for the user.

Next steps
When the user logs in to WebLM, the system prompts for a password change. The user must
change the password on the first login.

Troubleshooting standalone WebLM
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Proposed solution 2
WebLM stores the user data in an XML file called Users.xml. The system packages the XML file
in a WebLM.war file in the admin directory.

Before you begin
Log on to the WebLM server.

About this task
To reset the admin WebLM password, replace the existing user data file with the default WebLM
user data file.

Note:
When you replace the existing file with the default file, you lose all existing user data. You only
have the default user data for the admin user. You must add the data of the previously existing
users again from the WebLM Web interface.

Procedure
1. Stop Tomcat.

When Tomcat stops, applications deployed on the server that host Tomcat stop
responding.

2. Replace the existing Users.xml file with the default Users.xml file that you extracted
from the WebLM.war file located in the following directories:

• On a Linux system, $CATALINA_HOME/webapps/WebLM/admin
• On a Windows system, %CATALINA_HOME%\webapps\WebLM\admin

3. Start Tomcat.

4. On the log-in page, provide the following credentials: User Name = admin and Password
= weblmadmin.

5. At the system prompt, change the password and log in to the WebLM again using the new
password.

6. To add a new user to WebLM, on the WebLM Web interface, click Manage users and
follow the instructions provided in Adding a new user on page 41.

The system prompts the new user to change the password on the first login.

WebLM password errors

July 2019 Administering standalone Avaya WebLM 57
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering standalone Avaya WebLM


Chapter 6: Resources

Documentation
The following table lists the documents related to this product. Download the documents from the
Avaya Support website at http://support.avaya.com.

Title Use this document to: Audience
Overview
Avaya Aura® Virtualized
Environment Solution Description

Understand the high-level solution features
and functionality

Customers and
sales, services, and
support personnel

Implementing
Deploying Avaya Aura® applications Deploy the Avaya Aura® applications with

Solution Deployment Manager
Implementation
personnel

Deploying standalone Avaya
WebLM on VMware

Deploy standalone Avaya WebLM virtual
machine.

Implementation
personnel

Using
Using the Solution Deployment
Manager client

Deploy Avaya Aura® applications and install
patches on Avaya Aura® applications.

System
administrators

Related links
Finding documents on the Avaya Support website on page 58

Finding documents on the Avaya Support website
Procedure

1. Navigate to http://support.avaya.com/.

2. At the top of the screen, type your username and password and click Login.

3. Click Support by Product > Documents.

4. In Enter your Product Here, type the product name and then select the product from the
list.

5. In Choose Release, select an appropriate release number.
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6. In the Content Type filter, click a document type, or click Select All to see a list of all
available documents.

For example, for user guides, click User Guides in the Content Type filter. The list
displays the documents only from the selected category.

7. Click Enter.
Related links

Documentation on page 58

Training
The following courses are available on the Avaya Learning website at http://www.avaya-
learning.com. After you log into the website, enter the course code or the course title in the
Search field and click Go to search for the course.

Course
code

Course title Type

2007V/W What is New in Avaya Aura® Release 7.1.2 AvayaLive™ Engage Theory
2008V/W What is New in Avaya Aura® Application

Enablement Services 7.0
AvayaLive™ Engage Theory

2009V/W What is New in Avaya Aura® Communication
Manager 7.0

AvayaLive™ Engage Theory

2010V/W What is New in Avaya Aura® Presence Services
7.0

AvayaLive™ Engage Theory

2011/V/W What is New in Avaya Aura® Session Manager
Release 7.1.2 and Avaya Aura® System Manager
Release 7.1.2

AvayaLive™ Engage Theory

2012V Migrating and Upgrading to Avaya Aura®

Platform 7.0
AvayaLive™ Engage Theory

2013V Avaya Aura® Release 7.1.2 Solution
Management

AvayaLive™ Engage Theory

1A00234E Avaya Aura® Fundamental Technology AvayaLive™ Engage Theory
1A00236E Knowledge Access: Avaya Aura® Session

Manager and Avaya Aura® System Manager
Fundamentals

AvayaLive™ Engage Theory

5U00106W Avaya Aura® System Manager Overview WBT Level 1
4U00040E Knowledge Access: Avaya Aura® Session

Manager and System Manager Implementation
ALE License

5U00050E Knowledge Access: Avaya Aura® Session
Manager and System Manager Support

ALE License

Table continues…

Training
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Course
code

Course title Type

5U00095V Avaya Aura® System Manager Implementation,
Administration, Maintenance, and
Troubleshooting

vILT+Lab Level 1

5U00097I Avaya Aura® Session Manager and System
Manager Implementation, Administration,
Maintenance, and Troubleshooting

vILT+Lab Level 2

3102 Avaya Aura® Session Manager and System
Manager Implementation and Maintenance Exam

Exam (Questions)

5U00103W Avaya Aura® System Manager 6.2 Delta
Overview

WBT Level 1

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com and perform one

of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and
perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos
posted on the website.

Note:

Videos are not available for all products.

Resources
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Support
Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Related links
Using the Avaya InSite Knowledge Base on page 61

Using the Avaya InSite Knowledge Base
The Avaya InSite Knowledge Base is a web-based search engine that provides:

• Up-to-date troubleshooting procedures and technical tips

• Information about service packs

• Access to customer and technical documentation

• Information about training and certification programs

• Links to other pertinent information

If you are an authorized Avaya Partner or a current Avaya customer with a support contract, you
can access the Knowledge Base without extra cost. You must have a login account and a valid
Sold-To number.

Use the Avaya InSite Knowledge Base for any potential solutions to problems.

1. Go to http://www.avaya.com/support.
2. Log on to the Avaya website with a valid Avaya user ID and password.

The system displays the Avaya Support page.
3. Click Support by Product > Product Specific Support.
4. In Enter Product Name, enter the product, and press Enter.

5. Select the product from the list, and select a release.
6. Click the Technical Solutions tab to see articles.
7. Select relevant articles.

Related links
Support on page 61

Support
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Appendix A: Recommendations to select a
WebLM configuration model

Depending on the need and infrastructure of an organization, the organization can configure WebLM
in one of the following licensing models:

• WebLM standard model

• WebLM enterprise model

Related links
WebLM standard licensing model on page 62
WebLM enterprise licensing model on page 63
WebLM configuration model checklist on page 64

WebLM standard licensing model
WebLM standard licensing is an old model and offers an easy and simple solution with limited
functionality. Use the standard configuration model if the Avaya product is a standalone product
installed on a computer.

To configure a standard model, you must install a standard license file (SLF) and configure the
WebLM server for the licensed applications to acquire the feature licenses.

The standard model provides the following information regarding the feature license usage:

• Usage at a particular time

• Peak usage for the last 7 days

• Peak usage for the last 30 days

The standard licensing model does not support many new features of WebLM.

The standard licensing model has the following limitations:

• The model does not offer any redundancy because the model uses only one WebLM server
as the source of feature licenses. If the WebLM server fails or becomes unavailable due to
any reason, the licensed applications do not have other means to acquire feature licenses or
renew the acquired feature licenses.
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• The model does not suit an organization that has licensed applications spread globally. All
the licensed applications must contact a single WebLM server that might lead to network
issues.

• In this model, the WebLM server does not maintain the usage history.

Related links
Recommendations to select a WebLM configuration model on page 62
WebLM configuration model checklist on page 64

WebLM enterprise licensing model
WebLM enterprise licensing is a more recent model and offers more features to the end user as
compared to the WebLM standard licensing model. The WebLM enterprise licensing model
provides the following features:

• Provides the flexibility to move feature licenses across various WebLM servers, master and
local. Therefore, even if a WebLM server is unavailable or is out of feature licenses, the
licensed applications can still acquire feature licenses from the other servers.

• Suits an organization that has licensed applications spread globally. With the enterprise
model, the organization can have feature licenses allocated to various local WebLM servers,
which in turn can serve licensed applications in a region. Additionally, with the usage history,
the administrator can move WebLM feature licenses from local WebLM servers that have low
usage to the local WebLM servers that have high usage.

• Periodic allocation. The licensed application can also acquire feature licenses from the
master WebLM server. The unallocated feature licenses available with the master WebLM
server are known as floating licenses. To avoid feature licenses being stagnant in a single
location and maximize feature license usage, the allocation license files to local WebLM
servers are valid only for 30 days. However, to ensure that local WebLM servers never run
out of feature licenses, the master WebLM server copies the ALFs to the local WebLM
servers after every seven days. If the periodic allocation process fails, the retry feature
ensures that the system makes decent number of attempts to execute the process. If the
periodic allocation process is not successful even after the retry attempts, the system notifies
the administrator through an e-mail.

• Periodic usage query. The periodic usage query process retrieves feature license usage
information from each local WebLM server configured on the master WebLM server or the
floating license usage information from the master WebLM server after every seven days.
Using the periodic usage query feature, administrators of the master WebLM server can
ensure that administrators periodically receive feature license usage information, even if the
administrators forget to execute a usage query.

The usage information from the WebLM servers across the organization helps administrators to
determine if the purchased feature licenses are sufficient for the organization. If the feature
licenses are insufficient, administrators can plan to purchase more feature licenses for the
organization.

WebLM enterprise licensing model
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Related links
Recommendations to select a WebLM configuration model on page 62
WebLM configuration model checklist on page 64

WebLM configuration model checklist
The checklist for WebLM configuration model lists the features of WebLM with the summary of the
features each configuration model supports.
The WebLM team creates the WebLM configuration model checklist. Use the checklist to decide
the WebLM configuration model that suits the needs and infrastructure of your organization.

Feature WebLM Standard model WebLM Enterprise model
License Installation using user interface (UI) Yes Yes
Change Password Yes Yes
Feature Overuse Yes Yes
Manage Users (add, modify and delete) Yes Yes
License acquisition using client APIs - Pull
model

Yes Yes

Acquired license details Yes Yes
Update history count No Yes
Peak Usage (last 7 days) Yes Yes
Peak Usage (last 7 days) with history (max -
5)

No Yes

Peak Usage (last 30 days) Yes Yes
Peak Usage (last 30 days) with history (max
- 5)

No Yes

Usage query Yes Yes
Usage query with history (max - 5) No Yes
LAR license type support Yes Yes
Enterprise configuration No Yes
E-mail notification - in case of failure
(periodic operations)

No Yes

Local WebLM configuration - Add No Yes
Local WebLM configuration - Delete No Yes
Local WebLM configuration - Modify No Yes
Perform validate connectivity test No Yes
View usage at Enterprise level No Yes

Table continues…

Recommendations to select a WebLM configuration model
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Feature WebLM Standard model WebLM Enterprise model
Allocations (push ALF to Local WebLM) -
Push mode

No Yes

Periodic allocation (every 7th day) No Yes
Periodic usage query (every 7th day) No Yes
Redundancy No Yes
Floating license (available for acquisition) No Yes
Long term vision No Yes
HTTPS support Yes Yes
Client API Support (all APIs) Yes Yes

Related links
Recommendations to select a WebLM configuration model on page 62

WebLM configuration model checklist
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